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Section 1: Get Up and Running
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Chapter 1: Introduction
FileCenter Scan is a simple, reliable way to get paper documents and photos onto your
computer. The power of FileCenter Scan lies in its simplicity and its flexibility. Anyone can
quickly grasp the underlying principles and get up and running in no time.
This guide will teach you the basic concepts of FileCenter Scan. To make the best use of this
guide, first go through all of Section 1: Get Up and Running, then move on to Section 2: Getting
Sophisticated. Finally, Section 3: Tasks, will give you simple, step-by-step instructions for
performing common tasks and dealing with common issues.
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Chapter 2: Installation and Setup
This chapter will take you step-by-step through installation.

2.1 Install FileCenter Scan
To begin your installation, locate the setup file and double-click it.
If you’re not sure where to find the file and you downloaded it, look on your Desktop or in your
Downloads folder (usually at C:\Users\[username]\Downloads). Look for a file called “FileCenter
Setup_.exe”, where the underscore “_” will be a version number.
Once the installation starts, click through the screens, paying special attention to these:

All Users vs. Current User vs. Unique Profiles
You may or may not see an option asking whether you’d like to install for All Users, the Current
User Only, or All Users with Unique Profiles. Most users, unless they share their computer with
someone else, should select All Users.
You should only select Current User if you share your computer with another person and you
are the only one who will use FileCenter Scan.
If you share a computer and you want each user to have their own settings, or if you are a
network admin installing FileCenter Scan on a Terminal Server, select All Users with Unique
Profiles (which uses Windows roaming profiles).
Tip: In technical terms, the All Users option puts the FileCenter Scan settings in
C:\ProgramData\FileCenter, while the Current User and All Users with Unique Profiles options
put the settings in C:\Users\[username]\FileCenter.

2.2 Run FileCenter Scan for the First Time
Launch FileCenter Scan from the FileCenter Scan icon on your Desktop or from the Start menu >
All Apps/Programs > FileCenter Scan.
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Enter Your Product Key
The first thing you’ll see is a prompt to enter your Product Key. If you already purchased a
license of FileCenter Scan, your place of purchase will have given you a key. Enter it now.
Alternatively, select I Want to Start a Free Trial then select FileCenter Scan and Begin Trial.

Initial Setup
The first time you run FileCenter Scan, a setup wizard will guide you through the initial setup.
Follow the prompts using the information below for additional guidance.

Choose a Scanner
FileCenter Scan works with TWAIN scanners. That includes most scanners that plug directly into
your computer, and some wireless scanners. Most network scanners are not TWAIN scanners.
If you have a scanner connected to your computer, you can select it now. If it appears more
than once on the list, select the entry that does not have “WIA” in the name.
If you use a Fujitsu ScanSnap scanner, it won’t show up in the list but you can still use it with
FileCenter Scan. See p. 13, Scan with a ScanSnap for details.
We’ll cover scanners, scanner selection, and scanner troubleshooting in Chapter 4: Scanning
Basics.
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Chapter 3: The FileCenter Scan Interface
FileCenter Scan has a simple interface that is easy to understand and easy to navigate.
In this chapter we’ll take a look at the main sections of FileCenter Scan and show you where to
go to access the features you’re looking for.
If you look at the top of the FileCenter Scan interface, you will see a row of three tabs: Home,
Editor, and Files. Let’s take a closer look at each of those, beginning with Editor.

3.1 The Editor Tab
The Editor tab is where you will spend most of your time. Here you will perform scans and see
the results. The Editor tab holds a number of useful tools for editing, manipulating, and cleaning
up your scans.
You can also open existing scans here to make further changes to them, like adding pages or
doing cleanup tasks.
Once you perform a scan or open a scan, you will notice that scans appear as a row of tabs
across the top of the viewer. You can have multiple scans open at the same time. This becomes
especially useful if you need to move scanned pages between documents or combine scans,
something we’ll cover in Chapter 7: Work with PDF Files.
To the left of the main view area you’ll see a column of page thumbnails. This is an easy way to
navigate large, multi-page scans.
Everyone understands that if you open a file in Microsoft Word and change something, you
have to save your changes, otherwise you will lose them when you close. The Edit tab works the
same way. Be sure to save your scans before you close them.

3.2 The Files Tab
The Files tab is an easy way to see the files on your computer. Anything you can do in Windows
Explorer, you can do here: open files, delete files, rename files, copy files, move files, etc.; but
mostly, you will browse, organize, and manage your scans.
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To open a file, just double-click it. It will open in whatever Windows program normally handles
that kind of file. If it happens to be a scan, you’ll have the option of opening it in FileCenter
Scan.
There’s more to the Files tab than meets the eye. You can also open scans from here, scan
directly to file, or even append more pages to an existing scan.

3.3 The Home Tab
The Home tab is the place where you will manage your license(s). Here you can start free trials,
update your product keys, renew your maintenance plans, and add more user licenses.

3.4 The Ribbon
In addition to the task buttons, FileCenter Scan houses many of its power features in the ribbon.
The ribbon is simply the main toolbar that runs along the top of the interface. In fact, we’ll refer
to it as the Main Toolbar. Here are a few highlights:
Scan. Start a new scan any time by clicking the Scan button.
Open. You can open existing scans in FileCenter Scan. To see a list of your most recent scans,
click the drop-arrow next to the Open button.
Save. Save the scan you’re working on.
Email. With the Email button, you can quickly email a copy of the scan you have open. This is a
fast and simple way to share scans. Note that you must have an email program like Outlook,
Thunderbird, or Microsoft Mail installed on your computer. This feature does not work with
webmail, like Gmail accounts.
Cleanup. The Cleanup button holds a number of one-click cleanup tools for your scans.
Actions. The Actions button contains a whole toolbox of PDF manipulation features.
Convert. Use the Convert button to quickly convert a scan between different formats.
Extract/Insert. Use these options to pull pages out of a scanned document into a separate file,
or move pages from another file into the current one.
Tip: To scan more pages into the current file, just click the Scan button > Append Scan.
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Chapter 4: Scanning Basics
FileCenter Scan aims to make scanning as fast and easy as possible. We have worked hard to
streamline every aspect of scanning, reducing mouse clicks and eliminating extra steps and
complexity wherever possible.
While there are a lot of time-saving power features, which we’ll cover in Section 2: Getting
Sophisticated, this chapter will give you just enough detail to help you get started.

4.1 Scanner Requirements
To use the FileCenter Scan scanning features, you need a scanner that comes with a TWAIN
driver. Most desktop scanners do have TWAIN drivers, but if you’re in doubt, go out to your
scanner maker’s website and look for a “Downloads” or “Drivers” link. Locate your scanner, and
see if there’s a TWAIN driver you can download for your scanner and your version of Windows.
It’s not a bad idea to go ahead and download the driver, then install it. It will install just like a
program. This will ensure that you have the latest bug fixes and features for your scanner.

Portable Scanners
Portable scanners – small, thin scanners that run off a battery and work without being
connected to a computer – work a lot like digital cameras. Scans get saved right on the scanner
(often to a memory card). Then you connect the scanner to your computer and transfer the
scans over.
While you can’t use FileCenter Scan’s scanning features with portable scanners, you can view
the files in the Files tab. From there you can open the scans in the Editor and use FileCenter
Scan’s cleanup and manipulation tools.

ScanSnap Scanners
Fujitsu ScanSnap scanners have grown in popularity due to their ease-of-use and excellent
reliability. Unfortunately, they do not come with TWAIN drivers. This means that the Scan
button in FileCenter Scan won’t work with your ScanSnap.
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Fortunately, we have worked out an integration for the ScanSnap that will let you send scans to
FileCenter Scan. You can scan directly into Editor tab. The integration requires you to change a
couple of simple settings in your ScanSnap software. For instructions, see Task 1: Integrate with
a ScanSnap Scanner.
Important: You won’t be able to use the regular FileCenter Scan scanning features with your
ScanSnap, so the only section in this chapter that applies to you is p. 13, Scan with a ScanSnap.

Network Scanners
A “network scanner” is a scanner that isn’t connected to any computer. Instead, it sits on the
network and simply saves new scans to a folder.
FileCenter Scan can’t communicate with a network scanner (unless it happens to come with a
TWAIN driver, which is rare but not unheard of), so you won’t be able to use any of the
FileCenter Scan scanning features.
If you know where the network scanner is saving its scans, you can view them in the Files tab.
From there you can open the scans in the Editor and use FileCenter Scan’s cleanup and
manipulation tools.

4.2 Connect to Your Scanner
To connect to your scanner, make sure it’s plugged into your computer and turned on. Then:
1.
2.
3.
4.
5.

Click Scan in FileCenter Scan
Notice the Scanner field in the Options section, about mid-way down
Click the Select button
A scanner selection window will pop up; click Select Driver
A list of scanners will pop up; select your scanner

If your scanner shows up on the list more than once, see TWAIN vs. WIA below.

TWAIN vs. WIA
It’s not uncommon for a scanner to show up more than once on the list. When this happens,
one of the entries usually starts with WIA. In most cases, you should avoid this option.
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On rare occasions, the WIA option will work when other options don’t. So don’t be afraid to try
it, but only as a last resort.

4.3 Scan in the Editor
The most familiar way to scan is in the Editor tab. Let’s try a scan:
1. Make sure you’ve selected the Editor tab at the very top of FileCenter Scan
2. Click the Scan button on the main toolbar
3. For now, accept all of the defaults and just click Start Scan
Your scanner should perform the scan and it should show up in FileCenter Scan. If you
experience problems, see p. 13, Troubleshoot Scanner Problems.
You’ll notice that the scan opens in its own tab, above the viewer. You can have many scans
open at the same time.
If you’re happy with the scan, the next step is to save it. Just click the Save button on the main
toolbar, pick where to save the scan, and give it a name.
Once you’ve saved it, you can close the scan. Click the small “X” on the scan’s tab.

4.4 Scan Straight to File
The fastest, most efficient way to scan is directly to file in the Files tab. With this method,
you’re scanning and saving in one step, skipping the intermediate step of previewing the scan.
To see how it works, try this:
1.
2.
3.
4.

Make sure you’ve selected the Files tab at the very top of FileCenter Scan
Select a location
Click the Scan button on the main toolbar
Notice that now there’s a section on the Scan dialog called Save As with a Filename
option
5. Type in a filename; FileCenter Scan will save the file using this name
6. Accept all of the defaults and click Start Scan
Your scanner will perform the scan and it will show up as a new file in FileCenter Scan. Notice
that you’ve skipped the intermediate steps of previewing the scan, saving it manually, and
closing it.
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To see your scan, double-click it and select Open in Editor Tab.

4.5 Scan with a ScanSnap
With a Fujitsu ScanSnap scanner, you will normally want to scan in the Editor tab. Here’s the
workflow:
1.
2.
3.
4.
5.

Make sure you’ve selected the Editor tab at the very top of FileCenter Scan
Run your scan through the ScanSnap
If prompted, send the scan to FileCenter Scan
The file will open in the Editor view
When you’re satisfied with the scan, click Save and choose where to save it

The other option is to scan into the FileCenter Scan Files tab. This is a good option if you just
want to quickly organize the scan. The workflow is similar:
1.
2.
3.
4.
5.
6.

Make sure you’ve selected the Files tab at the very top of FileCenter Scan
Select the location where you want the scan to go
Perform your scan at the ScanSnap
If prompted, send the scan to FileCenter Scan
The file will show up in your current location in FileCenter Scan
FileCenter Scan will prompt you for the filename you want to use

Note: For the integration to work, you have to change a few ScanSnap settings. See Task 1:
Integrate with a ScanSnap Scanner.

4.6 Troubleshoot Scanner Problems
If you’re having trouble getting your scanner to work, see Task 2: Troubleshoot Scanner
Problems. If your scans are going through but there are problems with the images, see Task 4:
Troubleshoot Scanned Image Problems.

4.7 Document Scanning vs. Photo Scanning
Scanning documents is very different than scanning photos. To get the best results for each,
each one requires very different settings. We’ll be covering these settings in more detail on p.
17, Scanning Options Described, but for now it would be worthwhile to touch on a few of them.
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PDF or JPEG?
When you scan, you need to select the scan Type. This means the file format for the scan. The
two types you should focus on are PDF and JPEG.
PDF. PDF has become the standard for scanning documents. The key benefit to PDF is that it
can have multiple pages, making it ideal for documents.
JPEG. JPEG has become the standard for photo scanning. Digital cameras, for example, save
pictures as JPEG files. JPEG does not support multiple pages, so it is not suitable for document
scanning.

Color and DPI
The Color setting determines how many colors will be available in the scan. The more colors,
the larger the file size will be.
Scanning DPI means Dots Per Inch. A scan is made up of millions of tiny dots. The more dots per
inch, the smoother the scanned image will look. As a rule of thumb, you should scan at 300 x
300 DPI. A 300 DPI scan will look just like the original when you print it. A 200 DPI scan will be
slightly more rough around the edges, but still very acceptable.

Recommended Settings
As a rule of thumb, you should leave the DPI at 300 x 300. Then follow these guidelines:
Photos. Set the Type to JPEG. Set the Color to Color - 24 bit. This will give you an accurate
reproduction at the original size. If you plan to print an enlarged version of the photo, increase
the DPI. 600 DPI, for example, will let you create a double-sized print.
Documents. Set the Type to PDF. Set the Color to Black & White. This will give you a scanned
image that will print exactly like the original. For double-sided documents, also select Scanner
Duplex or Manual Duplex (see p. 27, Double-Sided Scanning).
Color Documents. Set the Type to PDF. For simple, flat colors, set the Color to Color - 8 bit.
For smaller files, consider setting the Color to Grayscale instead. Grayscale - 4 bit will give you
16 shades of gray, which is adequate for simple, flat colors. For documents with photo-quality
images in them, consider setting the Color to Grayscale - 8 bit. This will give you 256 shades of
gray.
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Setting the Color to Color - 24 bit will produce photo-perfect images, but at the cost of very
large file sizes.
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Section 2: Getting Sophisticated
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Chapter 5: All Scanning Features
We introduced you to scanning in Chapter 4: Scanning Basics. In this chapter, we’ll cover all of
the scanning options available.
In the next chapter – Scanning Techniques – we’ll take a more practical approach, showing you
how to use these features to streamline your scanning as much as possible.

5.1 Scanning Options Described
We’ve touched on a few of the options on the Scan dialog. Here’s a full description of all
options.
Important: Not all scanners support all of the options below. Also, your scanner may have
options that aren't listed here. To see a list of the actual options your scanner supports, select
the Use Scanner Dialog option when you scan.

Action
The scan Action controls what kind of scan you want to perform:
New Scan. This is the basic scanning option that you’ll use most of the time. It starts a new file.
Append Scan. You can append pages to an existing file. To make this option available, select the
file in Manage view or open it in Edit view, then click Scan > Append Scan. The scanned pages
will be added to the end of the file.
Prepend Scan. This is the same as Append Scan, except that the pages are added to the
beginning of the file.
Insert after Page. This is the same as Append Scan, except that you can choose where the pages
will be inserted. For example, if you want to insert some pages after page three, enter “3” as
the page position.

Scanner Options
Click Select next to the Scanner field to access the scanner options. There are three options that
control what scanner driver FileCenter Scan will use and how it will interface with the driver.
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Tweak these settings if you’re having a hard time getting FileCenter Scan to work with your
scanner.
Scanner. Use the Scanner option to select the scanner you want to use. If your scanner is listed
more than once, first try any option that does NOT have “WIA-” in the name. If your scanner
isn’t on the list, Windows doesn’t recognize it, either because it isn’t connected/turned on, or
because you don’t have a TWAIN driver installed for the scanner.
Mode. If FileCenter Scan is having a hard time communicating with your scanner, try changing
the Mode. There are a number of modes available, and one of them will usually work.
Transfer. If there are problems or crashes transferring the scanned pages into FileCenter Scan,
try changing the Transfer type. Most scanners support Native, but sometimes Memory and File
are more reliable.
Important: If you’re still having trouble getting your scanner to work, see Task 2: Troubleshoot
Scanner Problems. If your scans are going through but there are problems with the images, see
Task 4: Troubleshoot Scanned Image Problems.

Scan Tab
The following options are available on the Scan tab of the Scan dialog:
Type. This controls the file format for saving your scan. You can choose PDF, TIFF, or JPEG. Here
are the benefits and drawbacks of each:
PDF. This file format is quickly becoming the standard for archiving files. With PDF you get a
true reproduction of the original document that supports multiple pages.
TIFF. The TIFF format used to be the standard for scanning documents because, like PDF, it
supports multiple pages. TIFF has largely been replaced by PDF. It’s provided as an option for
those who still prefer the older format.
JPEG. The JPEG format is designed specifically for digital photos. Use JPEG for all of your photo
scanning.
Note: If you choose TIFF or JPEG, this will limit your OCR options since they don’t support
embedded text.
Color. This setting determines the color of your scan. The more colors you use, the larger the
file size will be. As a rule of thumb, you should generally scan documents in Black & White. This
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gives a good reproduction of the original but keeps the file size small. Grayscale will produce
smoother edges at the cost of file size. Color scans will produce very large files.
DPI. Scanning “DPI” refers to Dots Per Inch. A scan is made up of millions of tiny dots. The more
dots per inch, the smoother the scanned image will look. As a rule of thumb, you should scan
documents at 200-300 DPI. A 300 DPI scan will look just like the original when you print it. A
200 DPI scan will be slightly more rough around the edges, but still very acceptable. Resolutions
higher than 300 DPI will improve the printed quality if you plan to enlarge the scan, but will also
bloat the file size.
Paper. The Paper option tells the scanner the page size of the originals. The resulting scan will
match the dimensions of the paper size you select here.
Tip: Many scanners have automatic paper size detection. To use it, select Use Scanner Dialog
and Start Scan. This will pop up your scanner’s interface. Here you should look for an option like
Automatic in the paper size, or a setting called End of Page Detection, Auto-Crop, or something
similar.
Order. Most scanners give you the scanned pages in their original order. Some scanners,
however, reverse the order. You can correct this with the Order option. Select Reverse Simplex
for single-sided scans, or Reverse Duplex for double-sided scans.
Use Scanner Dialog. Your scanner will have some options beyond what FileCenter Scan shows.
You can see your scanner’s own scanning dialog with all of its options by selecting Use Scanner
Dialog. This will pop up your scanner’s dialog when you begin a scan.
Use Flat Bed. If you have a flatbed scanner (where you have to put each sheet down on the
glass yourself), select Use Flat Bed. Some flatbed scanners also have a sheet feeder. Select Use
Flat Bed when you want to scan from the glass, and de-select it when you want to use the sheet
feeder.
Scanner Duplex. Some scanners support double-sided scanning, meaning that both the front
and the back of the page can be scanned at the same time. You can turn double-sided scanning
(“duplex” scanning) on and off with the Scanner Duplex option. If you need to do a double-sided
scan but your scanner can only scan one side at a time, use Manual Duplex instead.
Manual Duplex. Use Manual Duplex to scan double-sided documents when your scanner can
only scan one side at a time. FileCenter Scan will guide you through two passes. First you scan
the front side, then the back. FileCenter Scan will then rearrange the pages in the right order:
page 1 front, page 1 back, page 2 front, page 2 back, etc.
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Invert Pages. Some scanners produce “inverted” or negative images – white text on a black
background. If your scanner creates negative images, correct it with the Invert Pages option.
Prompt for More. If you have a document that is too big to fit in the feeder or you have a
flatbed scanner, use Prompt for More. At the end of each scan, FileCenter Scan will ask if there
are more pages to scan. It won’t finalize the document until you’re done scanning.
Auto-Crop Pages. This option will attempt to trim excess whitespace or black edges off of the
page. It’s ideally suited for scanning receipts and other odd-sized pieces of paper. To crop pages
after-the-fact, see p. 23, Edit the Image after You Scan.
Tip: Many scanners have their own auto-crop functions. If your scanner supports auto-crop, use
it instead. Your scanner already knows the edges of the page and can do a more accurate
cropping. To see if your scanner supports auto-crop, select Use Scanner Dialog to pop up your
scanner’s interface when you scan. Then look for Auto-Crop, Auto-Trim, Automatic Paper Size
Detection, or something similar.
Deskew Pages. It’s common for sheet-fed scanners to pull pages through crooked, resulting in a
slightly rotated scan. The Deskew Pages option will try to straighten images automatically as
you scan so that you’ll always get upright pages. To straighten pages after-the-fact, see Edit the
Image after You Scan below.
Tip: Many scanners can automatically straighten the scans. This will often work better since the
scanner knows if the page is going through crooked. To see if your scanner can do this, select
Use Scanner Dialog and Start Scan. This will pop up your scanner’s interface. Here you should
look for an option called Deskew or Straighten Pages.

Adjust Tab
See p. 23, Adjust the Image Quality While You Scan.

Advanced Tab
Remove Blank Pages. FileCenter Scan can try to identify blank pages in the scan and drop them.
This happens as the scan comes in. To identify a blank page, FileCenter Scan looks at how much
of the page is white. If it’s almost completely white, FileCenter Scan will consider it blank and
drop it from the scan. To adjust the sensitivity, use the Blank Page Sensitivity setting, where a
low number tolerates no stray marks on the page and a high number will tolerate some
speckles and black marks.
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Default Scan Name. See p. 29, Quick Scanning with Profiles.
Other Options: See p. 36, Conversion Options.

5.2 Scanning Profiles
You may have two or three different ways you scan 90% of the time. Changing the same
settings over and over can become a real nuisance, not to mention inefficient and error-prone.
FileCenter Scan solves this problem by letting you save your most common scanner settings as
“profiles”, or presets. When you want to do a different kind of scan, just select the profile you
want to use and FileCenter Scan will apply the right settings for you.
Important: Some users scan with the Use Scanner Dialog option so they can see their scanner’s
native interface and all of the settings it exposes. You cannot include the settings on your
scanner’s dialog in a profile, only the settings available in FileCenter Scan.

Add a Profile
FileCenter Scan comes with one profile already: the Standard Profile. Let’s start by modifying
that profile:
1.
2.
3.
4.

Click the Scan button on the main toolbar
Right below the Scanner option, notice the Profile option
Change a couple of the settings on the grid
Click the Save button next to the Profile field

Now Cancel out of the Scan dialog, then go back in again. You’ll notice that the new settings
stuck. They were saved to the Standard Profile.
Now let’s create a new profile:
1. Set any options you’d like on the Scan dialog
2. Click the New button next to the Profile field
3. Give the new profile a name, and click OK to save it
Now back on the Scan dialog you’ll notice that your new profile is selected. In the Profile field,
switch to the Standard Profile then back to your new profile and watch how the options
change.
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When you want to scan, just select the profile you want to use, and FileCenter Scan will apply
the settings.
Note: Profiles can include any of the options below the Profile field, but not the ones above it.
For example, the scan Action and scanner selection can’t be part of a profile.

Scanning with a Profile
When you want to scan, just select the profile you want to use, and FileCenter Scan will apply
the settings.
Tip: You can select a profile then change the options a bit. That’s not a problem. Just select the
profile you want to use, then tweak the settings. The changes won’t stick with the profile unless
you click Save.

Modify or Delete a Profile
To modify an existing profile, first select it on the Profiles list, then select or de-select scanning
options, as desired, and click Save.
To delete a profile, just select it on the Profiles list, then click Delete.

Quick Scanning with Profiles
Back in the main FileCenter Scan interface, notice that there’s a drop-arrow under the Scan
button. At the bottom of this menu, you’ll see your scan profiles listed (you may have to close
and re-open FileCenter Scan if profiles you just added aren’t showing up).
You can select a profile from the list to immediately launch a scan, without using the Scan
dialog at all. Smart use of profiles with this quick-access list can speed up your scanning.

5.3 Adjust the Scanned Image
Modern scanners do a wonderful job, but occasionally you’ll run across a document that needs
extra tweaking. FileCenter Scan has a number of adjustments you can make both before and
after you scan. Your scanner may offer even more adjustments.
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Adjust the Image Quality While You Scan
Go to the Scan dialog and click the Adjust tab. There you’ll find settings that control the
brightness, contrast, and black/white balance of your scans. Note that these settings affect how
your scan comes in. You can’t use them after-the-fact.
Contrast. (For color/grayscale scans only). Contrast adjusts the distinctness of each
color/shade. For example, with low contrast, individual colors will be more muted and will
blend more. With high contrast, each color will be crisp and distinct. An example is twilight
versus mid-day. At twilight, colors fade and blend together (low contrast). At mid-day, colors
are sharp and distinct.
Brightness. (For color/grayscale scans only). Brightness adjusts the overall vibrancy of the
image. With low brightness, the image will be dim. With high brightness, the image will be
strong. Note that contrast and brightness work differently. For example, you could have high
contrast (each color is distinct and sharp) but low brightness, resulting in a muted but sharp
image.
Black/White Threshold. (For black & white scans only). You can think of the black/white
threshold as brightness for black-and-white scans. Lowering the threshold brightens the image
and raising it darkens the image. The truth is, this setting adjusts how sensitive your scanner is
to the image. A very low threshold will only pick up very obvious marks on the page, which is
good for reducing background speckling. A high threshold will let even tiny marks through,
which is good for scanning faded/dim pages.
Note: Not all scanners support these adjustments. It’s also possible that you scanner has more
options than FileCenter Scan exposes. To see all of the adjustments your scanner supports,
select the Use Scanner Dialog option when you scan.

Edit the Image after You Scan
After your scan comes in, you can make edits to the page: crop and straighten it, remove stray
marks and background noise, and erase or even redact (black out) parts of the text. To use
these features:
1.
2.
3.
4.

Open the scan in the Editor tab
Select the page you want to edit
Click the appropriate tool on the toolbar
Make your edits

· 23 ·

Here are the editing tools you’ll find:
Auto Straighten. This tool will automatically straighten a skewed/crooked page. It tries to figure
out the vertical/horizontal lines and de-skews the page accordingly.
Straighten. Use this tool to straighten a page manually. Click and drag to draw a line that
represents where the horizontal or vertical plane should be. For example, draw a line that
traces along the bottom of a line of text or along the left margin of the text. When you release
the mouse, the image will rotate to make your line level. Your line won’t stay on the image.
Auto Crop. Use Auto Crop tool to trim down the size of the page. This tool will automatically
crop off most of the white space around the image, leaving a small margin.
Crop. Use the Crop tool to trim down the size of the page. For example, if you scanned a small
receipt, you might want to trim the page down to the size of the receipt. Just select the Crop
tool then click and drag to draw a rectangle to the size you want your page to be. When you
release the mouse, the page will get trimmed.
Redact. The Redact tool is for blacking out sensitive information on the page. Click and drag to
draw rectangles over sections of the page you want to black out. Use the Redact tool when you
want it known that information was removed.
Erase Area. The Erase Area tool works just like the Redact tool, except instead of blacking out
sections of the page, it erases them.
Erase Outside. While the Erase Area tool erases everything inside of the rectangle, the Erase
Outside tool erases everything outside of the rectangle. For example, to remove black edges
and margin noise from your scan, drag and draw a rectangle around the body of the page.
Everything outside of the rectangle will get wiped clean.
Eraser. To erase small dots, use the Eraser tool. Click once on stray marks, or click and drag
across areas. Note that you can change the size of the eraser. Click the drop-arrow next to the
Eraser button and choose the size you want.
Despeckle. The Despeckle tool will automatically clean up dirty images. It analyzes your page,
identifies background “noise” and specks, and removes them from the page.
Invert. Some scanners produce a negative image. The Invert option corrects this. In other
words, it switches a black-on-white image to a white-on-black image.
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Automatic Image Cleanup
FileCenter Scan includes automatic image cleanup tools that can scrub an entire document at
once. To use it, simply click Cleanup on the main toolbar and choose the options you want to
use. The following options are available:
Deskew. This option will straighten each page if any of them are slightly angled, a common
problem when paper gets pulled through the scanner.
Despeckle. This option removes random “noise” from the scan – small stray dots and specks.
When you select the Despeckle option, you can also set the pixel threshold: only dots smaller
than the pixel size you specify will be removed.
Remove Border. Scanned images often end up with black lines along the edges of the page.
This option will remove them.
Remove Punch Holes. If the original document had punch holes for a binder, the holes often
come across in the scan as black circles. This option erases the black circles.
Remove Horizontal/Vertical Lines. You can remove all horizontal and/or vertical lines from the
document.
Convert to Black & White. To convert a grayscale or color PDF to black and white, select this
option.
Tip: Each of these tools is also available as an option when you scan.
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Chapter 6: Scanning Techniques
While we’ve now covered all of the scanning features and options, let’s shift our focus to the
practical side of it. In other words, let’s learn how to scan as quickly and easily as possible.
Many common scanning needs are, unfortunately, difficult to pull off in real life – things like
adding extra pages to an existing scan or scanning books and magazines. FileCenter Scan, on
the other hand, makes these tasks easy, if you know the right technique. We’ll cover those
techniques here.
Additionally, many offices and users deal with repetitive scanning – scanning the same kinds of
documents and forms over and over, day in and day out. This is the kind of scanning where
shaving off one step, or even one mouse click, actually pays dividends in the long run.
FileCenter Scan supports a number of scanning techniques that were designed specifically to
reduce the pain inherent in repetitive scanning.

6.1 Scan Multi-Page Documents
Inevitably, you will need to scan a document that has more pages than your scanner can hold.
Or perhaps you have a flatbed scanner and you have to scan every page by hand. In both cases,
you have the trouble of figuring out how to scan in multiple passes and combine it all into one
document.
FileCenter Scan has a Prompt for More feature designed especially for any situation where you
have to scan in stages. This works with books, magazines, or documents that exceed the
capacity of your scanner.
With this feature, you initiate the scan once, then FileCenter Scan will pause after each scan,
giving you a chance to load or position the next pages. You end up with a single file with all of
your pages in it. Here are the steps:
1.
2.
3.
4.
5.
6.

Load or position your first page
Click the Scan button on the main toolbar
If you’re using a flatbed scanner, select the Use Flatbed option
Select Prompt for More
Set any other scanning options you want
Click Start Scan
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7. FileCenter Scan will scan the first page (or batch of pages), then ask if you have more
pages to scan; don’t answer yet
8. Change the page(s) on the scanner
9. Now click Yes to scan the next page(s)
10. Continue like this until you’ve scanned all of the pages
When you’re done, FileCenter Scan will combine all of the pages into a single document.

6.2 Add More Pages to an Existing Document
What if you need to scan new pages into an existing file? For example, you want to add a
shipping receipt to a purchase order, or you need to add a signed addendum to a contract. Or
perhaps you’re scanning a long book and need to do it in shifts.
FileCenter Scan provides scanning options to make this easy:
1. Either open the file in the Editor tab or select it in the Files tab
2. Click Scan on the main toolbar
3. For the scanning Action, select either Append Scan (to place it at the end of the
document), Prepend Scan (to place it at the beginning of the document), or Insert after
Page and provide the page position where you want it inserted
4. Set any other scanning options
5. Proceed with the scan
FileCenter Scan will scan in the pages and insert them into your existing file.
Note: The scanning options you select will only apply to the new pages. They will not affect the
existing pages in the file.

6.3 Double-Sided Scanning
Many scanners have the ability to scan both sides of a page at once. Even if yours doesn’t,
FileCenter Scan can still help you scan two-sided documents.
FileCenter Scan and most scanner makers refer to double-sided scanning as Duplex Scanning.
Look at your scanner’s specifications and see if it mentions duplex or double-sided scanning.
FileCenter Scan has two duplex options, depending on whether your scanner has a duplex
mode:
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Scanner Duplex. If your scanner can scan both sides of a page at once, click Scan on the main
toolbar, then select the Scanner Duplex option. This will tell your scanner to scan both sides of
the page. We also recommend that you select Remove Blank Pages on the Advanced tab so that
blank sides won’t get included in the scan. To switch back to single-sided scanning, de-select
Scanner Duplex.
Manual Duplex. Use Manual Duplex when your scanner can only scan one side at a time. The
scan happens in two passes – first the front side, then the back side. Here’s how to use it:
1.
2.
3.
4.
5.

Load the document in your scanner so the front side will scan
Click Scan on the main toolbar
Select the Manual Duplex option
Scan the front side of the document
Next you’ll be prompted to pick up the stack, flip it around, and put it back in the feeder
so the back side will scan; DO NOT REORDER THE PAGES!
6. Scan the back side of the document
After the second scan finishes, FileCenter Scan will rearrange the pages in the right order: page
1 front, page 1 back, page 2 front, page 2 back, etc.
Note: The Remove Blank Pages option isn’t available with Manual Duplex. Once the scan’s
done, you’ll need to go through and delete blank pages yourself.

6.4 Scan Straight to File
One of the fastest ways to move paper documents into FileCenter Scan is in-place scanning
using the Files tab. This method skips the visuals of the Editor tab altogether. Instead, you scan
directly into a folder on your computer, scanning and saving in one step.
For example, suppose you are scanning old letters. You have set up a folder on your computer
to store the letters. In the Files tab, you can navigate to that folder, then click Scan. Your new
scan will be saved straight to file next to the other letters.
The steps are simple:
1.
2.
3.
4.
5.

Go to Files tab
Go to the drive/folder where you want to put the scan
Click Scan on the main toolbar
Enter the Filename you want to use on the scanning dialog
Click Start Scan
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The scan will be saved using the name you entered. If there is already another file using that
name in the same folder, FileCenter Scan will add an increment after the filename. It will never
overwrite an existing file.
Tip: If you select another file in the folder before clicking Scan, FileCenter Scan will put that
name in the Filename field. The resulting scan will use the same name with an increment. This
is a quick way to scan many of the same kind of document.

Making this Work with a ScanSnap
If you’ve turned on the ScanSnap integration using the instructions in Task 1: Integrate with a
ScanSnap Scanner, things will work roughly the same way. You’ll browse to the drive/folder
where you want to save the scan and perform the scan on your ScanSnap. When the scan
finishes, FileCenter Scan will prompt you to rename it.
If you have another file selected, FileCenter Scan will default to that filename, with an
increment.

6.5 Quick Scanning with Profiles
If there are a few kinds of files that you scan over and over, you can trim off even more mouse
clicks using Profiles and adding a filename. As we saw on p. 21, Scanning Profiles, profiles are
just a way to store different scanning configurations. One of those scanning options is a
filename. We also saw in that section that you can bypass the scanning dialog altogether by
scanning straight to a profile. By combining each of these pieces, we can come up with a very
fast scanning method.

How to Set it Up
First, set up each of your profiles following the instructions we gave on p. 21, Scanning Profiles.
The most important setting is Default Scan Name, which you’ll find under the Advanced tab on
the Scan dialog.
Some of your profiles may be identical except for the Filename. That’s ok.
When you’re done setting up the profile, click OK.
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How to Use It
Here’s how to scan with this technique:
1.
2.
3.
4.
5.

Make sure the document is in the scanner, ready to go
Go to the Files tab
Go to the drive/folder where you want to save the scan
Click the drop-arrow next to the Scan button
You’ll see your profiles listed at the bottom of the menu; pick the one that applies to
this document

The scan will start immediately, then drop your file in the folder, already named and ready to
go. If there’s another file with the same name in the folder, the new file will get an increment
(counter) after it.
Using this technique, you can perform scans in just two clicks – scanned, named, and filed.

6.6 Automatically Break Up Scans at Regular Intervals
If your office deals with standardized forms, you can scan whole stacks of them at once and
have FileCenter Scan split them up for you. On the Scan dialog’s Advanced tab, you’ll notice an
option called Separate Document Every __ Pages. If you select this option, FileCenter Scan will
take a single scan and break it out into multiple files. All you have to do is indicate how many
pages you want in each file.
For example, suppose you’re scanning a stack of three-page forms. Select Separate Document
Every __ Pages and enter “3” as the page interval. You’ll get a series files, each three pages
long.
If you perform the scan in the Files tab, each file will be saved separately, using the same name
with an increment. For example, supposing you set the Filename to “Patient Info”, you’ll end up
with files named Patient Info_1.pdf, Patient Info_2.pdf, etc.

6.7 Give a Scanned Document Keywords
There’s an easy way to give a scanned document searchable keywords that won’t be visible in
the document, but that will help you find the document through full-text searching.
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Make sure you’re in the Files tab and click the Scan button. Look for a Keywords field on the
scan dialog, right below the Filename field. If you don’t see it, make sure the scan type is set to
PDF.
Anything you enter in this field will be saved as a searchable keyword with the PDF.
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Chapter 7: Work with PDF Files
FileCenter Scan specializes in document scanning. This means scanning to PDF, the standard for
archiving and sharing documents. FileCenter Scan will scan your documents to PDF natively –
no extra steps required.
To help you get the most out of PDF scanning, you will find that FileCenter Scan packs a lot of
PDF power. You will find most of this in the Actions button on the main toolbar – things like
splitting or combining PDF files, pulling pages from a PDF into a new file, etc. These are the PDF
features that tend to operate at the page and file level; in other words, features that
manipulate pages or whole files.

7.1 The “Actions” Button
You will find a wealth of PDF features in the Actions button on the main toolbar. These actions
apply to the files you have open in the Editor tab.

Combine Documents
The Combine Documents option pulls multiple PDFs together into a single file. To use this
feature:
1. Open all of the PDFs in the Editor tab
2. Click Actions > Combine Documents
This will open the tool with the list of files you want to combine.
Note: This does not affect the source files. For example, if you are combining files A, B, and C
into file A, only file A is affected. Files B and C will remain intact.
Choose the Order. Put the files in the order you want them to appear in the final PDF. To
rearrange a file, select it in the list and use the Up/Down buttons to move it.
Choose a Destination. Now you need to choose a Destination. This is the resulting file – the one
that will have the whole stack of files in it. You have two options: create a new file, or overwrite
the first file in the list.
Optionally Close Files. You can choose to close each file after it gets combined.
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Optionally Create Bookmarks. FileCenter Scan can automatically bookmark the location of each
document in the resulting file. It will use the document’s original filename, minus the “PDF”
extension.
Combine the Documents. When you click OK, FileCenter Scan will create one unified file from
every file in the list, in the order you selected.

Insert Document
We already saw that Combine will join multiple files, one on top of the other. To insert a file in
the middle of another file, use Insert. To use this feature:
1. Open the target file in the Editor tab
2. Click Actions > Insert
3. Browse to the file you want to insert or optionally choose from other files that are
already open
4. Choose the page position where you want to insert the file

Unstack Document
The Unstack option pulls a file’s pages apart into multiple files. Specifically, it breaks up a file at
regular intervals. All you need to do is specify how many pages you want in each file. Here are
the steps:
1.
2.
3.
4.

Open a file in the Editor tab
Click Actions > Unstack
Indicate how many pages each document should receive
Optionally delete the original document after unstacking

Split Document
The Split tool works exactly like it sounds: it splits one document into two. You simply choose
the page position where the split should happen.
The first half of the document will keep the original name. The part that gets split off will be
opened in a new document tab.

· 33 ·

Transfer Pages
When you need to move pages between files (but keep the files separate), you’ll use the
Transfer Pages tool.
Open the Source File. The Transfer Pages tool “pushes” pages from one document to another.
So in the Editor tab, open the document that has the pages you want to move.
Choose the Pages. Next you need to choose the pages you want to transfer. You have three
ways you can do this.
If you just want to transfer the page you’re currently looking at, click Actions > Transfer Pages,
then select Current Page. In the thumbnail view, this is the page with a blue border around it.
For multiple pages, it’s easiest to select the thumbnails first. Hold down the Ctrl button while
you click the thumbnail of each page you want to transfer. Note that they will receive a blue
background, showing that they are selected. Now go to the Actions button > Transfer Pages and
choose the Selected Pages option.
Alternatively, go straight to Actions > Transfer Pages, then choose Custom Range. Here you’ll
enter page numbers for the pages you want to transfer. You can specify individual pages, page
ranges, or both. A few examples:
5, 7, 9
1-3
1-3, 5, 7, 9, 13-21

Choose the Target Document. Next you need to choose the file where you want to insert the
pages. Either choose Existing File and browse to the file, or if you have it open, select Already
Opened Document and select it in the list.
Choose the Page Position. Next you need to indicate the page position where you want to
insert the pages.
Optionally Delete Pages. Finally, you can choose to delete the pages from the original file. In
essence, you’re deciding whether to copy the pages between files or move them.
Transfer the Pages. When you click OK, FileCenter Scan will either copy or move the pages from
the source file into the file you chose, inserting them at the specified position.
This is probably the most complicated of the PDF tools, but it’s a powerful feature that can save
you extra work.
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Extract Pages
The Extract tool is similar to the Transfer tool, except instead of inserting pages into an existing
file, you’re making them into their own file. You might also think of it as a Split tool for grabbing
pages out of the middle of a file. Here’s how it works:
1.
2.
3.
4.
5.

Open the file in the Editor tab
Select the pages you want to extract, as described in Transfer Pages, above
Select Actions > Extract Pages
Choose whether to save the extracted pages to file or just open them in a new tab
Optionally choose to delete the original pages

FileCenter Scan will pull the pages into a new file. If you saved the pages to file, you’ll find the
file in the same directory as the original.
Extract and Save. You have another option in Actions called Extract & Save. This works just like
Extract, except that it doesn’t show you any options. Instead, it immediately prompts you to
save the new file. It’s a fast way to extract straight to file, especially when you need to save it
somewhere other than the original directory.

Delete Pages
The Delete Pages tool simply deletes pages from your PDF.
If you have a PDF open in the Editor tab, select the page(s) you want to delete, then go to
Actions > Delete Pages. To select multiple pages, hold down Ctrl while you click on the
thumbnails.

Print Document
Use this tool to print the current PDF:
1. Open the PDF you want to print
2. Go to Actions > Print Document
You’ll have a chance to choose a printer and any print options.
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7.2 Convert to PDF
Suppose you have an old TIFF scan and you want to convert it to PDF. FileCenter Scan allows
you to convert files between different formats. Just open the file in the Editor tab then click the
Convert button on the main toolbar.
For many kinds of files, just select the file in FileCenter Scan, then click the Convert button on
the main toolbar. FileCenter Scan will create a PDF copy of the file.

Conversion Options
You may see some of these conversion options, depending on what kind of file you’re
converting:
PDF/A-1b. Select this option to create a PDF/A-compatible file. PDF/A is an “archival” format
aimed at long-term storage. The idea is that PDF/A supports only certain PDF features that are
not allowed to change in upcoming decades, making the files readable long into the future.
Some government agencies require the PDF/A format.
Note: PDF/A does not support the full range of PDF features. You should not modify a PDF/A
file or you might introduce elements that aren’t compatible with PDF/A. PDF/A will also
produce larger file sizes.
Use Image Size as PDF Page Size. When you’re converting from an image file to PDF, FileCenter
Scan needs to know what size to make the PDF pages. You have two options: select a specific
page size, or base the page size on the size of the original image.
If you select Use Image Size as PDF Page Size, FileCenter Scan will make the PDF the same size
as the original image based on its dimensions and resolution.
The Force Image DPI option then lets you optionally specify the image’s resolution, which will in
turn affect its scale. Resolution is given in dots per inch. For example, assume an image is 400
pixels wide by 300 pixels tall. If you put the DPI as 100, your resulting PDF will be 4” x 3”.
Important: Most images already contain a setting with their ideal DPI. To use the image’s
default DPI, set Force Image DPI to 0. Only use the Force Image DPI setting if you want to make
the PDF page size larger or smaller.
Default Page Size. Instead of basing the PDF size on the size of the original image, you can force
the PDF to specific page size. Note that FileCenter Scan will scale the image to fit within the
page size.
· 36 ·

Force PDFs as Black and White. When you’re converting from an image file to PDF, you can
force color images to come over as black-and-white images. Some users prefer black-and-white
PDFs because they’re smaller.
PDF Compression. The compression settings control how your scanned images will be
compressed. Most users will get the best compression if they use JBIG2 when scanning in black
and white, and JPEG or JPEG + ZIP when scanning in grayscale or color. JPEG compression also
lets you set your JPEG quality, which has a dramatic effect on file size. The default quality of 75
strikes a good balance between file size and image quality. For a sharper image, at the cost of
file size, increase the quality. For a smaller file size, at the cost of graininess in the image,
decrease the quality.
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Section 3: Tasks
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Chapter 8: Common Tasks
In this chapter, we’ll cover common tasks and the steps needed to pull them off.

Task 1: Integrate with a ScanSnap Scanner
FileCenter Scan can receive scans from a ScanSnap scanner. To see how the integration works,
see p. 10, ScanSnap Scanners. Here, we’ll walk you through the setup.

Newer ScanSnap Scanners
Newer ScanSnap Scanners use the ScanSnap Home software. To add FileCenter Scan as a
scanning option, open ScanSnap Home and do the following:
1.
2.
3.
4.
5.

Click the Settings menu > Scan Settings
Click the Add Profiles button
Select Verify and Save Template on the left
Check Browse under Save Destination > Save To
Leave the location as the default (something like
C:\Users\[username]\AppData\Roaming\PFU\ScanSnap Home\ScanSnap Home)
6. Click Detailed Settings
7. Verify that all Document Type options are set to the file format PDF
8. Verify that Convert to Searchable PDF is UNCHECKED under the File Format tab
9. Verify that Blank Page Removal is CHECKED under the Scan tab
10. Click OK
Back on the Add New Profile page, continue the profile setup:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Click the dropdown for Send To under Application
Click Add or Remove
Click Add
Click Browse
Navigate to C:\Program Files (x86)\FileCenter\Main\
Select FileCenterScan.exe and click Open
Set the Display Name to FileCenter Scan
Click OK
Click Close
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10. Click the Send To dropdown under Application again
11. Select FileCenter Scan
12. Click Yes on the warning message that appears
Now complete the profile setup:
1. Select Verify and Save and the left and change the Profile Name to FileCenter Scan
2. Click the Add button at the bottom of the window to save the new profile
To see if the integration worked, do the following:
1.
2.
3.
4.

Start a scan with your ScanSnap
A menu of options will pop up
Look for FileCenter Scan
Click that option

Your scan should now show up in FileCenter Scan.

Older ScanSnap Scanners
For older ScanSnap Scanners that don’t include the ScanSnap Home software, follow these
instructions:
1. Locate the icon for the ScanSnap Manager in the system tray at the bottom-right corner
of the screen by the clock (it’s often a blue icon with a white “S”)
2. Right-click on the icon and select Scan Button Settings
3. De-select the option called Use Quick Menu
4. Select the Application tab (if you don’t see it, click the Detail button)
5. Select Add or Remove then Add
6. Call your new application FileCenter Scan
7. For the Application Path, browse out to FileCenter Scan (it’s typically located at:
C:\Program Files (x86)\FileCenter\Main\FileCenter.exe)
8. Click OK then Close to get back to the ScanSnap Manager
9. Switch over to the Save tab
10. Make sure that Rename File after Scanning is NOT selected
11. Switch over to the File Option tab
12. Make sure that Convert to Searchable PDF is NOT selected
Re-select Use Quick Menu then OK.
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Now open FileCenter Scan and go to a drawer or folder. Put a document in the ScanSnap
scanner and press the scan button on the scanner. It should scan and save the PDF to the
current location in FileCenter Scan.

Task 2: Troubleshoot Scanner Problems
First, an important point to understand: FileCenter Scan has no direct control over your
scanner. Scanners are controlled completely by their TWAIN driver and Windows. FileCenter
Scan only puts in “requests” to the driver through Windows and receives pages in return.
As a result, most scanning problems are actually driver problems, and the driver is the
responsibility of your scanner manufacturer.
FileCenter Scan does have a few different ways it can try talking with the driver, and sometimes
one method works better than the others. The instructions below will walk you through those
settings. But if those settings don’t work, you’ll need to try the instructions in Task 3:
Troubleshoot TWAIN Problems.

Quick Overview
Here are the basic steps for getting your driver to communicate with FileCenter Scan:
1. If your scanner shows up more than once in the scanner list, select the option that does
not have “WIA-” in the name
2. Try changing the Mode and/or Transfer type (next to the scanner option on the scanning
dialog)
3. Try scanning with the Use Scanner Dialog option turned on
4. Uninstall and update your drivers
We’ll now go through each of those steps in more detail.
Tip: If you're using a Neat Receipts scanner, the following settings seem to work best: Click Scan
as if starting a new scan. Next to the Scanner option click Select then set the Mode to "C" and
click OK. Next select the Use Scanner Dialog option. Finally, set the Order to Reverse Simplex for
single-sided scans, or Reverse Duplex for double-sided scans. Click the small Save link next to
the Profile option to make these the new defaults.
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1. Select the Right Scanner
Click the Scan button in FileCenter Scan. About mid-way down, you’ll notice a Scanner field.
Click the Select button next to it. This will bring you to the scanner options.
If you click Select Driver, you will see a list of every TWAIN scanner Windows recognizes on your
computer. If your scanner is there more than once, first try the one that doesn’t have WIA in
the name, then try the WIA option.

My Scanner isn’t on the List!
The list shows every scanner Windows can see. If Windows can’t see it, the scanner either
doesn’t have a TWAIN driver, or it isn’t turned on or plugged in properly. If you’re sure it’s
plugged in and turned on, first try a different USB cable (common problem) then skip to Get the
Right Driver below.
Tip: If your scanner is a Fujitsu ScanSnap, see p. 10, ScanSnap Scanners. If you have a network
scanner, see p. 11, Network Scanners.

2. Change the Scanning Mode and Transfer Type
While still in the Select Scanner dialog, notice the two options called Mode and Transfer. Do the
following:
1.
2.
3.
4.
5.
6.

Set the Mode to “A”
Set the Transfer type to “Native”
Try a scan
If the scan fails, change the Mode to “B”
Try a scan
If the scan fails, continue trying each one of the Mode options

If the scan fails at this point, change the Transfer type to “Memory” and start over, trying each
of the modes. Then change the transfer type to “File” and try each of the modes again,
continuing in this manner until you find a combination that works.
Further explanation: The Modes are different ways of communicating with your scanner’s
driver, and the Transfer types are different ways of getting an image back from the driver. This
might help you narrow in on which setting to change. For example, if you can’t even get a scan
to start, you probably need to change the Mode. If you get problems after a page has gone
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through the scanner, you might need to change the Transfer type. But often you’ll need to
change both settings.
Tip: If you get an error that the scanner is busy or in use, you’ll need to reboot your computer
and switch your scanner off then back on.

3. Show the Scanner Dialog
Some scanners have problems if you don’t scan through their interface. This can include
everything from crashes to blank or skipped pages to problems with resolution and paper size.
On FileCenter Scan’s Scan dialog, select the option called Use Scanner Dialog then click Start
Scan. Your scanner’s interface will pop up. Proceed with the scan. If it works, you will want to
make this setting permanent:
1.
2.
3.
4.

Go to Settings > Scan
Select Use Scanner Dialog
Click Save near the top of the dialog
Click OK

4. Get the Right Driver
As we mentioned, your scanner’s drivers are the communication link between the scanner and
FileCenter Scan. If the driver isn’t working, your first step is to remove the old driver:
1.
2.
3.
4.
5.

Unplug or power off your scanner
If you’re not using Windows XP, go to the Windows Control Panel > Devices and Printers
If your scanner shows up here, right-click on it and select Remove Device
Go to the Windows Control Panel > Programs and Features (or Add/Remove Programs)
If your scanner shows up here, select it and click Uninstall

Now install an updated driver:
1.
2.
3.
4.
5.
6.

Note the scanner manufacturer
Note the scanner model number (find it on the bottom or back of the scanner)
Go to the scanner maker’s website
Look for a link that says Downloads, Drivers, or Support
There should be an option to look up a driver for your scanner
Download the TWAIN driver setup file for your version of Windows
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7. Run the setup file
8. Follow the instructions in the setup
9. Turn on your scanner; Windows should find and recognize it
10. Now you should see the scanner in FileCenter Scan; if it shows up more than once,
select the option that does not have “WIA” in the name

Common Problems and Solutions
Here are some common problems and how to correct them:

Some Scanning Options are Disabled
Turn off the option called Use Scanner Dialog.

Error: Scanner is Busy
Your scanner failed to reset itself after the last scan. Sometimes you can just switch the scanner
off, wait a couple of seconds, then turn it back on. If this doesn’t work, reboot your computer.

Error: Device or Scanner Cannot be Found
Switch your scanner off, wait a couple of seconds, then turn it back on again.
If that doesn’t work, carefully check your scanner connections. You should also try plugging the
scanner into a different USB port on your computer, and even try a different cable. We’re
always surprised how often USB cables and ports go bad.
Failing this, try rebooting.
If your computer still can’t find the scanner, see Task 3: Troubleshoot TWAIN Problems.

Error: Cannot Connect to Scanner
If you connect to your scanner through the network, your firewall could be interfering. Go to
the Control Panel > Windows Firewall and allow FileCenter.exe to access the network. The steps
vary between versions of Windows. Do a quick Google search for “windows firewall allow
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program windows ___”, filling in the blank with your version of Windows (e.g. “windows
firewall allow program windows 8”).

Error in the TWAIN Manager
This usually means that your drivers are damaged or corrupted, to the point that it’s crashing
Windows’ TWAIN manager. You’ll probably have to purge your TWAIN drivers and reinstall
them fresh. See Task 3: Troubleshoot TWAIN Problems.

There’s a Crash when I Scan
If you get crashes when you scan, see Task 3: Troubleshoot TWAIN Problems.

Task 3: Troubleshoot TWAIN Problems
Your scanner’s TWAIN driver is the communication link between FileCenter Scan and the
scanner. TWAIN drivers are managed by Windows. The communication chain works like this:
FileCenter > Windows > TWAIN driver > scanner

If you’ve installed the right driver but Windows still doesn’t recognize your scanner, can’t
connect to it, or crashes when you scan, your only recourse might be to purge all of your
TWAIN drivers and reinstall them. If you’re getting TWAIN Manager errors, you’ll have to do
this. Sometimes old, faulty drivers stick around, even if you think they’ve been deleted, and
stop Windows from being able to communicate with the good ones.
Here’s how to remove your drivers:
1.
2.
3.
4.
5.

Go to the Windows Control Panel > Programs and Features or Add/Remove Programs
Find any scanners on the list and uninstall them
Reboot your computer
Go to C:\Windows
Delete everything in the TWAIN and TWAIN32 folders (if they exist), but don’t delete the
folders themselves
6. Reboot your computer
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Now go to your scanner manufacturer’s website and download the TWAIN driver that matches
your scanner AND your version of Windows. If you use a 64-bit edition of Windows, be sure the
driver is specifically designed for 64-bit environments.
Install the driver. Drivers install just like programs.

Task 4: Troubleshoot Scanned Image Problems
Here are some common problems with scanned images and how to correct them.

Image is a Negative
If the image looks like a negative – white text on a black background – open the Scan dialog,
then select the Invert Pages option. To make this setting permanent, click the Save button right
above the list of options.

Image is Too Light/Dark
Open the Scan dialog and switch to the Advanced tab. If this is a black-and-white scan, adjust
the Threshold. If it’s a grayscale or color scan, Adjust the Brightness and/or Contrast.

Wrong Page Size
If the scanned page size doesn’t match the original, open the FileCenter Scan Scan dialog and
set Paper Size to the size of the original. If this option is grayed out, you’ll need to set the page
size on your scanner’s interface, which will pop up automatically when you scan.
Tip: Many scanners have automatic paper size detection. On the FileCenter Scan Scan dialog,
select Use Scanner Dialog and Start Scan. This will pop up your scanner’s interface. Here you
should look for an option like Automatic in the paper size, or a setting called End of Page
Detection, Auto-Crop, or something similar.
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Pages are in Reverse Order
If your pages are showing up in reverse order, use the Order option to correct them. On the
Scan dialog, change the Order to Reverse Simplex for single-sided scans, or Reverse Duplex for
double-sided scans.

Image is Crooked
If the image is crooked on the page, first see if your scanner can automatically straighten the
scans. On the FileCenter Scan Scan dialog, select Use Scanner Dialog and Start Scan. This will
pop up your scanner’s interface. Here you should look for an option called Deskew or
Straighten Pages.
If your scanner can’t straighten the scans automatically, FileCenter Scan can try to straighten
them for you. On the FileCenter Scan Scan dialog, select the option called Deskew Pages. To
make the setting permanent, click the Save button right above the list of options.

All or Most Pages are Blank
Some scanners only work if you scan through their interface. Open the FileCenter Scan Scan
dialog and select the option called Use Scanner Dialog and Start Scan. This will pop up your
scanner’s interface. Go ahead with your scan.
If you still get blank pages, go through the all of the steps in Task 2: Troubleshoot Scanner
Problems.

Task 5: Back Up Your Settings
If you have created extensive scanning profiles, you may want to back them up.
First, you can have your regular backup software back up these settings. You simply need to
add FileCenter Scan’s settings folder to your list of backup paths. More on that below.
You may also want to create your own backup. For example, if you’re moving FileCenter Scan to
a new computer, you can move your settings between computers.
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Find Your Settings Folder
All of FileCenter Scan’s settings are stored in a single folder. To find your settings folder:
1.
2.
3.
4.

Click the drop-arrow by the Help button
Select Support Options
Select Browse Settings
A window will pop up with all of your settings files

This is your settings folder. Either add this folder to your backup or copy every file in this folder
to make your own backup.

Task 6: Reinstall FileCenter Scan
Most of the time, you can install FileCenter Scan right over the top of an older version. The new
version will automatically pick up all of the settings from the old version.
If you fear that a program file has gotten corrupted, you might want to uninstall the old version
first, then reinstall:
1.
2.
3.
4.

Go to the Windows Control Panel
Go to Add or Remove Programs
Select FileCenter on the list
Click Uninstall

When the uninstall finishes, reboot your computer to ensure all files get removed. Then
reinstall. All of your data, settings, and customizations will remain in place.

Do a Fresh Install
If you want to completely remove FileCenter Scan, including all, you’ll also need to remove the
FileCenter Scan settings folder. The settings will be in one of these locations:
C:\ProgramData\FileCenter
C:\Users\[your username]\AppData\Roaming\FileCenter
C:\Documents and Settings\All Users\FileCenter
C:\Documents and Settings\[your username]\FileCenter

Here’s an easy way to completely remove FileCenter Scan:
1. In FileCenter Scan go to the drop-arrow by the Help button > Support Options
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2.
3.
4.
5.
6.
7.
8.

Select Browse Settings
An explorer window will open to the settings folder; minimize it for now
Close FileCenter Scan
Uninstall FileCenter Scan as described above
Go back to the explorer window you minimized
Delete everything in it
Reboot your computer

That should completely remove FileCenter Scan. You can check the program folder to make
sure it was removed. It will be in one of these places:
C:\Program Files\FileCenter
C:\Program Files (x86)\FileCenter

Task 7: Move FileCenter Scan to a New Computer
When it’s time to move FileCenter Scan to a new computer, all you really need is your Product
Key. You can view your product key by going to the Home tab.
If you have set up many scanning profiles and want to preserve them, you can move your
settings to the new computer.

Move Your Settings (optional)
All of FileCenter Scan’s settings are stored in a single folder. You can move this settings folder to
your new machine.
You’ll need a way to move the folder over to your new computer: a thumb drive, a USB drive, a
CD or DVD burner, or a network drive.
On Your Old Computer:
1.
2.
3.
4.

Go to the drop-arrow by the Help button > Support Options
Click Browse Settings
An Explorer window will open to your FileCenter Settings folder; minimize it for now
Close FileCenter Scan

Now its time to copy all of your settings:
1. Go back to the Explorer window you just minimized

· 49 ·

2.
3.
4.
5.

Press the Backspace button on your keyboard (NOT the Delete button)
You should now see a list of folders
Right-click on the FileCenter folder and select Copy
Go to your thumb drive (or other drive you’re using to transfer files) and paste the
folder there (right-click > paste or type Ctrl+V)

On Your New Computer:
1.
2.
3.
4.
5.
6.

Install FileCenter Scan; just install it as a 30-day trial for now
Open FileCenter Scan
Go to the drop-arrow by the Help button > Support Options
Click Browse Settings
Again, and Explorer window will open; minimize it for now
Close FileCenter Scan

Now it’s time to copy the settings onto your new machine:
1.
2.
3.
4.
5.
6.
7.

Go to your thumb drive (or other drive you’re using to transfer files)
Right-click on the FileCenter folder and select Copy
Go back to the Explorer window you just minimized
Press the Backspace button on your keyboard (NOT the Delete button)
You should now see a list of folders
Paste the FileCenter folder there (right-click in empty space > paste or type Ctrl+V)
Select “Yes” when asked if you want to overwrite the existing files

When you restart FileCenter Scan, all of your settings should be restored.
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